
Microsoft Offi ce PowerPoint 2007

Creating a Presentation with 
Illustrations and Shapes2

Objectives
You will have mastered the material in this chapter when you can:

• Create slides from a blank 
presentation

• Change views to review a 
presentation

• Change slide layouts

• Add a background style

• Insert, move, and size clip art

• Insert a photograph from a fi le

• Delete a placeholder

• Change font color

• Format text using the Format Painter

• Add and size a shape

• Apply Quick Styles to placeholders 
and shapes

• Select slide transitions

• Preview and print an outline and 
handout
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2 Creating a Presentation with 
Illustrations and Shapes
Introduction
In our visual culture, audience members enjoy viewing effective graphics. Whether reading 
a document or viewing a PowerPoint presentation, people increasingly want to see photo-
graphs, artwork, graphics, and a variety of type. Researchers have known for decades that 
documents with visual elements are more effective than those that consist of only text because 
the illustrations motivate audiences to study the material. People remember at least one-third 
more information when the document they are seeing or reading contains visual elements. 
These graphics help clarify and emphasize details, so they appeal to audience members with 
differing backgrounds, reading levels, attention spans, and motivations.

Project — Presentation with Illustrations and a Shape
The project in this chapter follows graphical guidelines and uses PowerPoint to create 
the presentation shown in Figure 2–1. This slide show, which discusses identity theft, has 
a variety of illustrations and visual elements inserted on a gray background. Clip art and 
photographs add interest. Transitions help one slide fl ow gracefully into the next during a 
slide show. Slide titles have a style that blends well with the background and illustrations. 
The slide handouts include an outline of the slides and print all four slides on one page.

This presentation uses Quick Styles, which are collections of formatting options 
for objects and documents. The Quick Styles, like the document themes introduced in 
Chapter 1, are created by Microsoft’s visual designers and give your presentation a profes-
sional look. When you rest your mouse pointer on a Quick Style thumbnail in the Quick 
Style gallery, you will see how the various colors, fonts, and effects are combined, and you 
can select the image that best fi ts the impression you want to present in your slide show.

Overview
As you read through this chapter, you will learn how to create the presentation 

shown in Figure 2–1 by performing these general tasks:

• Create a new presentation from a blank presentation.
• Review presentation in a variety of views.
• Insert and format shapes.
• Insert photographs and clips.
• Print an outline and a handout.

Delivery Skills
While illustrations and 
shapes help audience 
members retain 
important points in 
a slide show, keep in 
mind that a speaker’s 
presentation skills are 
the most effective part 
of a presentation. The 
presenter’s posture, eye 
contact, volume, gestures, 
and rate establish the 
tone and tempo of the 
presentation. A good 
presentation rarely 
overcomes poor 
delivery skills.
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Figure 2–1

(a)  

(b) 

(c)  

(d)  
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Starting PowerPoint
Chapter 1 introduced you to starting PowerPoint, selecting a document theme, creating 
slides with bulleted lists, and printing a presentation. The following steps summarize 
starting a new presentation. To start PowerPoint, Windows must be running. If you are 
using a computer to step through the project in this chapter and you want your screen to 
match the fi gures in this book, you should change your computer’s resolution to 1024 � 768. 
For more information about how to change a computer’s resolution, see Appendix E.

General Project Guidelines
When creating a PowerPoint presentation, the actions you perform and decisions you make 
will affect the appearance and characteristics of the fi nished document. As you create a 

presentation with illustrations, such as the project shown in Figure 2–1, you should follow 
these general guidelines:

1. Focus on slide text content. Give some careful thought to the words you choose to use. 
Some graphic designers advise starting with a blank screen so that the document theme 
does not distract from or infl uence the words.

2. Use single quotation marks. PowerPoint slides generally use a single quotation mark in 
several instances.

 • The introduction of an unfamiliar term 

 • A quotation

 • Nicknames

 • Composition titles

3. Adhere to copyright regulations. Copyright laws apply to printed and Web-based 
materials. You can copy an existing photograph or artwork if it is in the public domain, if 
your company owns the graphic, or if you have obtained permission to use it. Be certain 
you have the legal right to use a desired graphic in your presentation.

4. Use color effectively. Your audience’s eyes are drawn to color on a slide. Used appropriately, 
color can create interest by emphasizing material and promoting understanding. Be 
aware of symbolic meanings attached to colors, such as red generally representing 
danger, electricity, and heat.

5. Use serif fonts for titles and sans serif fonts for body text. Typefaces are divided into two 
categories: serif and sans serif. A serif letter generally has thin and thick areas, with the 
thin areas at the end of the lines. A sans serif letter generally is the same thickness. The 
letters in this box are sans serif.

6. Choose graphics that serve a purpose. Illustrations and art should help your audience 
remember and understand information. They should be uncluttered and visually appealing. 
Determine why you need each graphic and the kind of information it communicates.

7. Consider graphics for multicultural audiences. In today’s intercultural society, your presentation 
might be viewed by people whose fi rst language is different from yours. Some graphics 
have meanings specifi c to a culture, so be certain to learn about your intended audience 
and their views.

When necessary, more specifi c details concerning the above guidelines are presented at 
appropriate points in the chapter. The chapter also will identify the actions you perform and 
decisions made regarding these guidelines during the creation of the presentation shown in 
Figure 2–1.

Plan
Ahead
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To Start PowerPoint

1   Click the Start button on the Windows taskbar to display the Start menu.

2   Point to All Programs on the Start menu and then point to Microsoft Offi ce on the All 
Programs submenu.

3   Click Microsoft Offi ce PowerPoint 2007 on the Microsoft Offi ce submenu.

4   If the PowerPoint window is not maximized, click the Maximize button on its title bar.

Creating Slides from a Blank Presentation   PPT 85

Focus on slide text content.
Once you have researched your presentation topic, many methods exist to begin developing 
slide content.

• Select a document theme and then enter text, illustration, and tables.

• Open an existing presentation and modify the slides and theme.

• Import an outline created in Microsoft Word.

• Start with a blank presentation that uses the default Offi ce Theme. Consider this practice 
similar to an artist who begins creating a painting with a blank, white canvas.

Experiment using different methods of developing the initial content for slides. Experienced 
PowerPoint users sometimes fi nd one technique works better than another to stimulate 
creativity or help them organize their ideas in a particular circumstance.

Plan 
Ahead

Creating Slides from a Blank Presentation
In Chapter 1, you selected a document theme and then typed the content for the title and 
text slides using single- and multi-level bulleted lists. In this chapter, you will type the 
slide content for the title and text slides, select a background, and then format the text.

To Create a Title Slide

Recall from Chapter 1 that the title slide introduces the presentation to the audience. 
In addition to introducing the presentation, this project uses the title slide to capture the 
audience’s attention by using title text and a shape, which is a movable, resizable graphical 
element. You will add this shape after you have typed the text for all four slides. The following 
step creates the slide show’s title.

1   Type Protect Your Good Name in the title text placeholder (Figure 2-2 on the next page).

Introducing the 
Presentation
Before your audience 
enters the room, start the 
presentation and display 
Slide 1. This slide should 
be visually appealing and 
provide general interest 
in the presentation. An 
effective title slide gives a 
good fi rst impression.
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Figure 2–2

shape will be 
inserted in this 
location

title text entered 
in placeholder

Use sans serif fonts for content text.
When a new slide is displayed during your presentation, your audience members focus on 
the title and then read the words in the content placeholder. Generally more words appear 
in the content placeholder, so designers use sans serif typefaces to decrease reading time.

Plan
Ahead

To Create the First Text Slide with a Single-Level Bulleted List

The fi rst text slide you create in Chapter 2 describes tips for helping prevent thieves 
from accessing personal information. The four suggestions are displayed as second-level 
paragraphs. The following steps add a new slide (Slide 2) and then create a text slide with a 
single-level bulleted list.

1  Click the New Slide button in the Slides group.

2  Type Reduce Access to Personal Data in the title text placeholder.

3  Press CTRL+ENTER, type Shred credit card offers in the content text placeholder, 
and then press the ENTER key.

4  Type Use a locked mailbox and then press the ENTER key.
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5  Type Mail envelopes inside the post offi ce and then press the ENTER key.

6  Type Remove listing from telephone directory but do not press the ENTER key.

7  Italicize the word, inside, in the third bulleted paragraph (Figure 2–3).

Figure 2–3

italicized 
wordSlide 2 text 

entered

To Create the Second Text Slide with a Single-Level Bulleted List

The second text slide contains suggestions to help computer users protect their 
sensitive electronic fi les from cyber-intruders. The following steps add a new slide (Slide 3) 
and then create a text slide with a single-level bulleted list.

1  Click the New Slide button in the Slides group.

2  Type Internet and Security Safeguards in the title text placeholder.

3  Press CTRL+ENTER, type Install a fi rewall in the content text placeholder, and then 
press the ENTER key.

4  Type Install and update virus protection software and then press the 
ENTER key.

Creating Slides from a Blank Presentation   PPT 87
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5  Type Never respond to phishing e-mail and then press the ENTER key.

6  Type Use credit, not debit, cards when shopping but do not press the ENTER key  
(Figure 2–4).

Figure 2–4

Slide 3 text 
entered

Use single quotation marks.
Type an apostrophe for the single quotation mark. PowerPoint generally will invert the fi rst 
single quotation mark, making it an open-quotation mark, after you type a second single 
quotation mark, which then becomes a close-quotation mark.

Plan
Ahead

To Create the Third Text Slide with a Single-Level Bulleted List

The fi nal text slide in your presentation provides information to protect people 
using an automatic teller machine (ATM). “Shoulder surfers” position themselves near an 
ATM and often use binoculars and cameras to capture a user’s personal identifi cation 
number (PIN). The following steps add a new slide (Slide 4) and then create a text slide 
with two second-level bulleted paragraphs.

1  Click the New Slide button in the Slides group.

2  Type Beware of 'Shoulder Surfers' in the title text placeholder.

3  Press CTRL+ENTER, type Shield your hand when entering your PIN in the content 
text placeholder, and then press the ENTER key.

4  Type Thieves may be watching with binoculars but do not press the ENTER key  
(Figure 2–5).
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To Choose a Background Style

Now that the basic text paragraphs for the title and three text slides have been entered, you need to make 
design decisions. In creating Project 1, you chose a theme that determined the colors, fonts, and effects. You also can 
select these elements individually without choosing a theme. In Project 2, you will choose a background that fi ts the 
tone of your presentation and then choose fonts and effects. PowerPoint provides 12 white, ivory, blue, and black 
background styles. Background styles have designs that may include color, shading, patterns, and textures. Fill 
effects add pattern and texture to a background, which add depth to a slide. The following steps add a background 
style to all slides in the presentation.

Figure 2–5

Slide 4 text 
entered

single quotation 
marks used in title

Creating Slides from a Blank Presentation   PPT 89

1
• Click Design on the 

Ribbon to display 
the Design tab.

• Click the Background 
Styles button in 
the Background 
group to display the 
Background Styles 
gallery (Figure 2–6).

I Experiment

• Point to various 
styles themes in the 
Background Styles 
gallery and watch 
the backgrounds 
changes on the slide. 

Are the backgrounds 
displayed in a 
specifi c order?

Yes. They are arranged 
in order from white to black running from left to right. The fi rst row has solid backgrounds; 
the middle row has darker fi lls at the bottom; the bottom row has darker fi lls on the sides. If 
you point to a background, a ScreenTip with the background’s name appears on the screen. 

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Bubble width
p6 on both sides

Figure 2–6

Background 
Styles gallery

Background Styles 
button selectedDesign tab

Background Style 12 
desired for all slides

default white 
background style

Q
&

A
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2
• Click Background 

Style 12 to apply this 
background to all the 
slides (Figure 2–7).

If I decide later that 
this background 
style does not fi t 
the theme of my 
presentation, can 
I apply a different 
background?

Yes. You can repeat 
these steps at any 
time while creating 
your presentation.

What if I want to 
apply this background 
style to only one slide?

When the gallery 
is displaying, 
right-click the 
desired style and 
then click Apply to 
Selected Slides. Figure 2–7

Presentation 1 is 
default fi le name

Save button on 
Quick Access Toolbar

Background 
Style 12 applied 
to all slides

Q
&

A
Q

&
A

To Save a Presentation

Recall from Chapter 1 that it is wise to save your presentation frequently. With all 
the text for your presentation created, the following steps save the presentation on a USB 
fl ash drive using the fi le name, Identity Theft.

1  Connect a USB fl ash drive to one of the computer’s USB ports and then click the Save 
button on the Quick Access Toolbar.

2  Type Identity Theft in the File name text box. Do not press the ENTER key after typing 
the fi le name. Click the Save in box arrow.

3  Click UDISK 2.0 (E:) in the Save in list.

4  Click the Save button in the Save As dialog box.

Changing Views to Review a Presentation
In Chapter 1, you displayed slides in Slide Show view to evaluate the presentation. Slide 
Show view, however, restricts your evaluation to one slide at a time. Recall from Chapter 1 
that Slide Sorter view allows you to look at several slides at one time, which is why it 
is the best view to use to evaluate a presentation for content, organization, and overall 
appearance. After reviewing the slides, you can change the view to Normal view to 
continue working on the presentation.

Experimenting with 
Normal View
As you become more 
comfortable using 
PowerPoint, experiment 
with using the Outline 
tab and with closing the 
Tabs pane to maximize 
the slide area. To close the 
Tabs pane, click the X to 
the right of the Outline 
tab. To redisplay the 
Tabs pane, click the View 
tab on the Ribbon and 
then click Normal in the 
Presentation Views group.

B
T
W

C6167_PPT_02.4c.indd   90C6167_PPT_02.4c.indd   90 3/7/07   10:37:46 AM3/7/07   10:37:46 AM



Po
w

er
Po

in
t 

C
h

ap
te

r 
2

To Change the View to Slide Sorter View

You can review the four slides in this presentation all in one window. The following step changes the view 
from Normal view to Slide Sorter view.

1
• Click the Slide Sorter 

view button at the 
lower right of 
the PowerPoint 
window to display 
the presentation in 
Slide Sorter view 
(Figure 2–8).

Why is Slide 4 
selected?

It is the current slide 
in the slide pane.

Figure 2–8

Slide Sorter button 
displays slides in 
Slide Sorter view

project name changed 
from Presentation1 to new 
fi le name, Identity Theft

four slide 
thumbnails display

Q
&

A
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To Change the View to Normal View

You can make changes to text in Normal view and on the Outline tab. It is best, however, to change the view 
to Normal view when altering the slide layouts and formats so you can see the results of your changes. Switching 
between Slide Sorter view and Normal view helps you review your presentation, assess whether the slides have an 
attractive design and adequate content, and are organized for the most impact. The following steps change the view 
from Slide Sorter view to Normal view.

1

• Click the Normal 
view button at the 
lower right of the 
PowerPoint window 
to display the pre-
sentation in Normal 
view (Figure 2–9).

Figure 2–9

Normal view button 
displays slides in 
Normal view
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Changing Layouts
When you developed this presentation, PowerPoint applied the Title Slide layout for 
Slide 1 and the Title and Content layout for the other three slides in the presentation. 
These layouts are the default styles. A layout specifi es the arrangement of placeholders on a 
slide. These placeholders are arranged in various confi gurations and can contain text, such 
as the slide title or a bulleted list, or they can contain content, such as SmartArt graphics, 
pictures, charts, tables, shapes, and clip art. The placement of the text, in relationship to 
content, depends on the slide layout. You can specify a particular slide layout when you 
add a new slide to a presentation or after you have created the slide.

Using the Layout gallery, you can choose a slide layout. The nine layouts in this gallery 
have a variety of placeholders to defi ne text and content positioning and formatting. Three lay-
outs are for text: Title Slide, Section Header, and Title Only. Five are for text and content: Title 
and Content, Two Content, Comparison, Content with Caption, and Picture with Caption. The 
Blank layout has no placeholders. If none of these standard layouts meets your design needs, you 
can create a custom layout. A custom layout specifi es the number, size, and location of place-
holders, background content, and optional slide and placeholder-level properties.

When you change the layout of a slide, PowerPoint retains the text and objects and 
repositions them into the appropriate placeholders. Using slide layouts eliminates the need 
to resize objects and the font size because PowerPoint automatically sizes the objects and 
text to fi t the placeholders. 

To Change the Slide Layout to Two Content

Notice the slides have a signifi cant amount of space and look plain. These observations indicate a need to add 
visual interest to the slides. The next several sections improve the presentation by changing layouts and adding clip 
art and photos. Before you add these graphical elements, you must change the slide layouts.

Adding clip art and a photograph to Slides 2, 3, and 4 requires two steps. First, change the slide layouts and 
then insert the clip or photo into the content placeholders. The following steps change the slide layout on Slide 2 
from Title and Content to Two Content.

1
• Click the Previous 

Slide button on the 
vertical scroll bar 
twice to display 
Slide 2.

• Click Home on the 
Ribbon to display 
the Home tab.

• Click the Layout 
button in the 
Slides group on the 
Home tab to display 
the Layout gallery 
(Figure 2–10).

Figure 2–10

Home tab

Two Content 
layout desired for 
Slides 2 and 3

Picture with Caption 
layout desired for Slide 4

default Slide 2 Title 
and Content layout

Previous Slide 
button

Layout gallery

Using the Find 
Command
Rather than viewing 
all the slides in your 
presentation to look for a 
particular word or phrase 
you typed, use the Find 
command to locate this 
text. Click the Home tab, 
click the Find button in 
the Editing group, type 
the text in the Find what 
text box, and then click 
the Find Next button.
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2
• Click Two Content 

to apply that 
layout to Slide 2 
(Figure 2–11).

Why did the bulleted 
list move to the left 
placeholder?

PowerPoint 
assumes you want 
your bulleted list to 
display on the left 
side of your slide. If 
you want the list to 
display on 
the right side, 
you will need 
to move the 
placeholders 
on the slide.

Figure 2–11

Two Content layout 
applied to Slide 2

content placeholder will 
hold graphic elements

bulleted list moved 
to left placeholder

Q
&

A

To Change the Slide Layout to Two Content

Slide 3 also will have a bulleted list and a graphic element, so the layout needs to 
change to accommodate this slide content. The following steps change the Slide 3 layout 
to Two Content.

1   Click the Next Slide button.

2   Click the Layout button in the Slides group on the Home tab to display the Layout gallery.

3   Click Two Content to apply the layout to Slide 3 (Figure 2–12).
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To Change the Slide Layout to Picture with Caption

The Slide 4 text discusses exercising caution while using an automatic teller 
machine (ATM). You have a photograph of a person using an ATM, and you want to 
display this graphic prominently on the slide. The Picture with Caption layout serves this 
purpose well, so the layout needs to change to accommodate this slide content. The following 
steps change the Slide 4 layout to Picture with Caption.

1   Click the Next Slide button.

2   Click the Layout button in the Slides group.

3   Click Picture with Caption to apply the layout to Slide 4 (Figure 2–13).

Why did the font size of the title and bulleted list text decrease?

PowerPoint reduced the font size to make room for the large upper content placeholder. 
You can increase the font size of this text if you desire. 

Figure 2-12

Next Slide 
button

Two Content layout 
applied to Slide 3

Q
&

A
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Inserting Clip Art and Photographs into Slides
A clip is a single media fi le, including art, sound, animation, and movies. Adding a clip can help 
increase the visual appeal of many slides and can offer a quick way to add professional-
looking graphic images and sounds to a presentation without creating these fi les yourself. 
This art is contained in the Microsoft Clip Organizer, a collection of drawings, photo-
graphs, sounds, videos, and other media fi les shared with Microsoft Offi ce applications. 
The Offi ce Collections contains all these media fi les included with Microsoft Offi ce.

You also can add your own clips to slides. You can insert these fi les directly from a 
storage medium, such as a USB fl ash drive. In addition, you can add them to the other fi les 
in the Clip Organizer so that you can search for and reuse these images, sounds, anima-
tions, and movies. When you create these media fi les, they are stored on your hard disk in 
My Collections. The Clip Organizer will fi nd these fi les and create a new collection with 
these fi les. Two other locations for clips are Shared Collections and Web Collections. Files 
in the Shared Collections typically reside on a shared network fi le server and are accessed 
by multiple users. The Web Collections clips reside on the Microsoft Clip Art and Media 
Home page on the Microsoft Offi ce Online Web site. They are available only if you have 
an active Internet connection.

text font size decreased 
to accommodate large 
content placeholder

Figure 2–13

photograph will 
display in large 
content placeholder

Picture with 
Caption layout 
applied to Slide 4

The Clip Art Task Pane

You can add clips to your presentation in two ways. One way is by selecting one of the slide layouts that 
includes a content placeholder with a Clip Art button. A second method is by clicking the Clip Art button in the 
Illustrations area on the Insert tab. Clicking the Clip Art button opens the Clip Art task pane. The Clip Art task 
pane allows you to search for clips by using descriptive keywords, fi le names, media fi le formats, and clip collections. 
Specifi c fi le formats could be for clip art, photographs, movies, and sounds. Clips are organized in hierarchical clip 
collections, which combine topic-related clips into categories, such as Academic, Business, and Technology.

Importing Clips
Previous versions of 
PowerPoint imported 
clips automatically 
the fi rst time a user 
desired to insert clips. 
PowerPoint 2007 requires 
the user to import the 
clips on fi rst use by 
clicking the Organize 
clips link in the Clip 
Art task pane, clicking 
the File menu in the 
Favorites – Microsoft Clip 
Organizer dialog box, 
pointing to Add Clips 
to Organizer in the File 
menu, and then clicking 
Automatically.
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Clips have one or more keywords associated with various entities, activities, labels, and emotions. In most 
instances, the keywords give the name of the clip and related categories. For example, an image of a cow in the Animals 
category has the keywords animals, cattle, cows, dairies, farms, and Holsteins. You can enter these keywords in the 
Search for text box to fi nd clips when you know one of the words associated with the image. Otherwise, you may 
fi nd it necessary to scroll through several categories to fi nd an appropriate clip.

To Insert a Clip from the Clip Organizer into a Content Placeholder

Depending on the installation of the Microsoft Clip Organizer on your computer, you may not have the clip 
art used in this chapter. Contact your instructor if you are missing clips used in the following steps. If you have an 
open connection to the Internet, clips from the Microsoft Offi ce Online Web site will display automatically as the 
result of your search results.

With the Two Content layout applied to Slide 2, you insert clip art into the right content placeholder. The 
following steps insert clip art of a shredder into the content placeholder on Slide 2.

Figure 2–14 

Clip Art 
task pane

right content 
placeholder

Clip Art 
button

type clip
keyword in Search 
for text box

1
• Click the Previous Slide button 

twice to display Slide 2.

• Click the Clip Art button in the 
content placeholder to display the 
Clip Art task pane.

• Click the Search for text box in 
the Clip Art task pane, delete any 
letters that are present, and then 
type shredder in the Search for 
text box (Figure 2–14).
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2
• Click the Go button so that the 

Microsoft Clip Organizer will 
search for and display all pictures 
having the keyword, shredder.

• If necessary, click the Yes button if 
a Microsoft Clip Organizer dialog 
box appears asking if you want to 
include additional clip art images 
form Microsoft Offi ce Online.

• If necessary, scroll down the list to 
display the shredder clip shown in 
Figure 2–15

• Click the clip to insert it into the 
right content placeholder 
(Figure 2–15).

What if the shredder image 
displayed in Figure 2–15 is not 
shown in my Clip Art task pane? 

Select a similar clip. Your clips 
may be different depending on 
the clips installed on your com-
puter and if you have an open 
connection to the Internet. 

What is the blue globe image 
that displays in the lower-left 
corner of the clips in the Clip Art 
task pane? 

The globe indicates that the 
image was obtained from the 
Microsoft Offi ce Online Web site. 

Photographs and the Clip Organizer
In addition to clip art, you can insert pictures into a presentation. These may 

include scanned photographs, line art, and artwork from compact discs. To insert a picture 
into a presentation, the picture must be saved in a format that PowerPoint can recognize. 
Table 2–1 identifi es some of the formats PowerPoint recognizes.

You can import fi les saved with the .emf, .gif, .jpg, .png, .bmp, .rle, .dib, and .wmf 
formats directly into PowerPoint presentations. All other fi le formats require separate 
fi lters that are shipped with the PowerPoint installation software and must be installed. 
You can download additional fi lters from the Microsoft Offi ce Online Web site.

Figure 2–15

Go button

Picture Tools and 
Format tabs appear 
when clip is selected

Q
&

A
Q

&
A

Adhere to copyright regulations.
You have permission to use the clips from the Microsoft Clip Organizer. If you want to use 
a clip from another source, be certain you have the legal right to insert this fi le in your 
presentation. Read the copyright notices that accompany the clip and are posted on the 
Web site. The owners of these images and fi les often ask you to give them credit for using 
their work, which may be satisfi ed by stating where you obtained the images.

Plan
Ahead

desired clip inserted 
in right content 
placeholder
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Table 2–1 Primary File Formats PowerPoint Recognizes

Format File Extension

Computer Graphics Metafi le .cgm

CorelDRAW .cdr, .cdt, .cmx, and .pat

Encapsulated PostScript .eps

Enhanced Metafi le .emf

FlashPix .fpx

Graphics Interchange Format .gif

Hanako .jsh, .jah, and .jbh

Joint Photographic Experts Group (JPEG) .jpg

Kodak PhotoCD .pcd

Macintosh PICT .pct

PC Paintbrush .pcx

Portable Network Graphics .png

Tagged Image File Format .tif

Windows Bitmap .bmp, .rle, .dib

Microsoft Windows Metafi le .wmf

WordPerfect Graphics .wpg

To Insert a Photograph from the Clip Organizer into a Slide

Next you will add a photograph to Slide 3. You will not insert this picture into a 
content placeholder, so it will display in the center of the slide. Later in this chapter you 
will resize this picture and then delete the right placeholder because it is not being used. 
To start the process locating this photograph, you do not need to click the Clip Art button 
icon in the content placeholder because the Clip Art task pane already is displayed. The 
following steps add a photograph to Slide 3.

1  Click the Next Slide button to display Slide 3.

2  Click the Search for text box in the Clip Art task pane and then delete the letters in the 
text box. 

3  Type credit card and then click the Go button.

4  If necessary, scroll down the list to display the picture of a credit card shown in Figure 2–16 
and then click the photograph to insert it into Slide 3 (Figure 2–16).

Why is my photograph so large on the slide? 

The photograph was inserted into the slide and not into a content placeholder. You will 
resize the picture later in this chapter. 

Q
&

A
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To Insert a Photograph from a File into a Slide

The fi nal image to insert in the presentation is a photograph on Slide 4. This slide uses the Picture with Caption 
layout, so the picture will display in the top placeholder. The following steps add a picture from the Data Files for 
Students. See the inside back cover of this book for instructions on downloading the Data Files for Students, or contact 
your instructor for more information on accessing the required fi les. The following steps insert a photograph of a student 
using an automatic teller machine (ATM).

Figure 2–16

clicking Close button 
closes task pane

Go buttontype photograph 
keyword in Search 
for text box

desired photograph 
inserted in Slide 3

1
• Click the Next Slide 

button to display 
Slide 4.

• Click the Close button 
in the Clip Art task 
pane so that it no 
longer is displayed 
(Figure 2–17).

Figure 2–17

photograph will be 
placed in content 
placeholder

task pane no 
longer appears

Insert Picture 
from File icon
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2
• Click the Insert 

Picture from File 
icon in the content 
placeholder to 
display the Insert 
Picture dialog box.

• With your USB fl ash 
drive connected to 
one of the computer’s 
USB ports, if neces-
sary, click the Look in 
box arrow and then 
click UDISK 2.0 (E:) to 
select the USB fl ash 
drive, Drive E in this 
case, in the Look in 
list as the device that 
contains the picture.

• Click ATM to select 
the fi le name 
(Figure 2–18).

What if the 
photograph is not 
on a USB fl ash drive?

Use the same process, but be certain to select the device containing the photograph in the 
Look in list. 

Figure 2–18

Look in 
box arrow

selected 
picture fi le

Insert button

any pictures on 
selected device 
appear in this list

USB fl ash drive is 
selected device

Insert Picture 
dialog box

Q
&

A

3
• Click the Insert button in the 

dialog box to insert the picture 
into Slide 4 (Figure 2–19).

Figure 2–19

picture inserted in 
content placeholder
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1
• Click the Previous Slide button two 

times to display Slide 2.

• Click the shredder clip to select 
it and display the selection 
rectangle.

• Point to the upper-left corner sizing 
handle on the clip so that the 
mouse pointer shape changes to a 
two-headed arrow (Figure 2–20).

Resizing Clip Art and Photographs
Sometimes it is necessary to change the size of clip art. Resizing includes both enlarging 
and reducing the size of a clip art graphic. You can resize clip art using a variety of techniques. 
One method involves changing the size of a clip by specifying exact dimensions in a dialog 
box. Another method involves dragging one of the graphic’s sizing handles to the desired 
location. A selected graphic appears surrounded by a selection rectangle, which has small 
squares and circles, called sizing handles or move handles, at each corner and middle 
location. 

To Resize Clip Art

On Slide 2, much space appears around the clip, so you can increase its size. The photograph on Slide 3 is too 
large for the slide, so you should reduce its size. To change the size, drag the corner sizing handles to view how the 
clip will look on the slide. Using these corner handles maintains the graphic’s original proportions. Dragging the 
square sizing handles alters the proportions so that the graphic becomes more or less high or more or less wide. 
The following steps increase the size of the Slide 2 clip using a corner sizing handle.

Figure 2–20

blue line is 
selection 
rectangle

upper-left 
sizing handle

mouse pointer 
shape changes to 
two-headed arrow

sizing handles
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2
• Drag the sizing handle diagonally 

toward the center of the slide until 
the mouse pointer is positioned 
approximately as shown in 
Figure 2–21.

What if the clip is not the same 
size shown in Figure 2–21?

Repeat Steps 1 and 2. 

Figure 2–21

mouse pointer 
shape changes to 
cross hair

selection rectangle indicates 
original clip art size

3
• Release the mouse button to resize the clip. If necessary, select the clip and then use the ARROW keys to position the clip 

as shown in Figure 2-21.

Q
&

A

4
• Click outside the 

clip to deselect it 
(Figure 2–22).

What happened to 
the Picture Tools and 
Format tabs?

When you click 
outside the clip, 
PowerPoint 
deselects the clip and 
removes the Picture 
Tools and Format 
tabs from the screen. 

What if I want to 
return the clip to 
its original size and 
start again?

With the graphic 
selected, click the 
Reset button in 
the Slides group on the 
Home tab.

Figure 2–22

sizing handles 
do not appear

shredder clip 
is resized

Reset button 
returns clip to 
original size

Picture Tools and 
Format tabs removed 
when clip is deselected

Q
&

A
Q

&
A
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To Resize a Photograph

The credit card picture in Slide 3 fi lls the middle of the slide and covers some text, so 
you should reduce its size. The following steps resize this photograph using a sizing handle.

1  Click the Next Slide button to display Slide 3.

2  Click the credit card photograph to select it.

3  Drag the upper-left corner sizing handle on the photograph diagonally inward until the 
photograph is resized approximately as shown in Figure 2–23.

Figure 2–23

right content 
placeholder not 
selected

resized 
photograph
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To Delete a Placeholder

The credit card photograph was inserted into the slide and not into a content placeholder. The right content 
placeholder, therefore, is not needed, so you can delete it from the slide. The following steps delete this placeholder.

Figure 2–24

placeholder 
border is displayed 
as solid line

sizing handles 
indicate right content 
placeholder selected

1
• Click the right content placeholder 

to select it.

• Click the edge of the placeholder 
so the border is displayed as a 
solid line (Figure 2–24).

2
• Press the DELETE key to delete 

the placeholder from Slide 2 
(Figure 2–25).

right 
content 
placeholder 
deleted

Figure 2–25
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2
• Click the Previous Slide button to 

display Slide 2.

• Click the shredder clip to select it, 
press and hold down the mouse 
button, and then drag the 
photograph toward the right 
side of the slide (Figure 2–27).

To Move Clips

After you insert clip art or a picture on a slide, you may want to reposition it. The credit card photograph on 
Slide 3 and the shredder clip on Slide 2 could be centered in the spaces between the bulleted text and the right edge 
of the slide. The following steps move these graphics.

1
• Click the credit card photograph 

on Slide 3 to select it and then 
press and hold down the mouse 
button.

• Drag the photograph 
diagonally upward toward the 
word, Safeguards (Figure 2–26).

photograph 
located in 
desired position 
on Slide 3

Figure 2–26

clip located 
in desired 
position on 
Slide 2

Figure 2–27
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To Save an Existing Presentation with the Same File Name

You have made several changes to your presentation since you last saved it. Thus, 
you should save it again. The following step saves the presentation again.

1  Click the Save button on the Quick Access Toolbar to overwrite the previous Identity Theft 
fi le on the USB fl ash drive.

Formatting Title and Content Text
Choosing well-coordinated colors and styles for text and objects in a presentation is 
possible by using Quick Styles, which are defi ned combinations of formatting options. 
The styles in the Quick Styles Gallery have a wide variety of font, background, and 
border colors. You even can create a custom Quick Style and give it a unique name. Once 
you select a particular Quick Style and make any other font changes, you then can copy 
these changes to other text using the Format Painter. The Format Painter allows you to 
copy all formatting changes from one object to another.

To Format Title Text Using Quick Styles

The 42 Quick Styles are displayed in thumbnails in the Quick Style gallery. When you place your mouse 
pointer over a Quick Style thumbnail, PowerPoint changes the text and shows how the Quick Style affects the 
formatting. The title text in this presentation will have a light orange background, a dark orange border, and black 
letters. The following steps apply a Quick Style to the title text.

1
• Click the Slide 2 title 

text placeholder to 
select it.

• Click the Quick 
Styles button in the 
Drawing group in 
the Home tab to 
display the Quick Styles 
gallery. Point to 
the Subtle Effect – 
Accent 6 Quick Style 
(row 4, column 7) 
to display a live 
preview of the style 
(Figure 2–28).

I Experiment

• Point to various 
styles in the Quick 
Styles gallery and 
watch the format 
of the text, 
backgrounds, and 
borders change in 
the placeholder.

Quick Styles 
button

Subtle Effect – Accent 6 
Quick Style effect is 
previewed in title text 
placeholder

desired 
Quick 
Styles 
effect

Figure 2–28 

Quick 
Styles 
gallery

Inserting Special 
Characters
You can insert characters 
not found on your 
keyboard, such as 
the Euro sign (€), the 
copyright sign (©), and 
Greek capital letters 
(e.g., �, �, �). To insert 
these characters, click the 
Insert tab on the Ribbon, 
and then click the Symbol 
button in the Text group. 
When the Symbol dialog 
box is displayed, you can 
use the same font you 
currently are using in your 
presentation, or you can 
select another font. The 
Webdings, Webdings 2, 
and Webdings 3 fonts 
have a variety of symbols.

B
T
W
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2
• Click the Subtle 

Effect – Accent 6 
Quick Style (row 4, 
column 7) to apply 
this format to the 
title text placeholder 
(Figure 2–29).

Subtle Effect – Accent 
6 Quick Style effect is 
applied to title text 
placeholder

Figure 2–29

To Format Remaining Title Text Using Quick Styles

Once you have applied a Quick Style to one title text placeholder, it is a good idea to 
use the same style for consistency. The following steps apply the Subtle Effect – Accent 6 
Quick Style to the title text placeholder on Slides 3 and 4.

1  Click the Next Slide button to display Slide 3. Click the title text placeholder and then click 
the Quick Styles button in the Drawing group to display the Quick Styles gallery.
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2  Click the Subtle Effect – Accent 6 Quick Style (row 4, column 7) to apply this format to the 
title text placeholder.

3  Click the Next Slide button to display Slide 4. Click the title text placeholder, click the 
Quick Styles button, and then click the Subtle Effect – Accent 6 Quick Style (row 4, 
column 7) to apply this format to the title text placeholder (Figure 2–30).

Subtle Effect – 
Accent 6 Quick Style 
effect is applied to 
title text placeholder

Figure 2–30

Use serif fonts for titles.
The design guidelines for title text differ from the guidelines for content body text. You 
would like your audience members to remember the main points of your presentation, and 
you can help their retention by having them read the title text more slowly than they read 
the words in the content text placeholder. The uneven lines in serif typefaces cause eye 
movement to slow down. Designers, therefore, often use serif fonts for the slide title text.

Plan 
Ahead
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To Change the Heading Font

The default Office Theme heading and body text font is Calibri with a font size of 28 point. Calibri is a 
sans serif font, and designers recommend using a serif font to draw more attention to the slide title text. The 
following steps change the font from Calibri to Cambria.

3
• Click Cambria (or a similar font) 

to change the font of the selected 
text to Cambria (Figure 2–32).

1
• Click the Previous Slide button two 

times to display Slide 2. Triple-click 
the title text paragraph. With the 
text selected, click the Font box 
arrow in the Font group on the 
Home tab to display the Font 
gallery (Figure 2–31).

Will the fonts in my Font gallery be 
the same as those in Figure 2–31?

Your list of available fonts may 
differ, depending on the type of 
printer you are using.

Font box arrow
Home tab

Calibri font 
applied and text 
remains selected

Figure 2–31

list of available 
fonts is 
displayed in 
Font gallery

use scroll arrow or 
scroll bar to display 
more fonts

fonts defi ned in current 
theme for headings 
and body text

Q
&

A

2
• Scroll through the Font gallery, 

if necessary, and then point to 
Cambria (or a similar font) to 
display a live preview of the title 
text in Cambria font.

I Experiment

• Point to various fonts in the Font 
gallery and watch the font of the 
title text change in the document 
window.

font of selected text 
changed to CambriaFont box displays 

fonts of selected text, 
which is Cambria

Figure 2–32

1. Click Font box arrow on Mini 
toolbar, click desired font in 
Font gallery

2. Right-click selected text, click 
Font on shortcut menu, click 
Font tab, select desired font 

in Font list or type a font in 
Font box, click OK button

3. Click Dialog Box Launcher in 
Font group, click Font tab, 
select desired font in Font 

list or type a font in Font 
box, click OK button

4. Press CTRL+SHIFT+F, click 
Font tab, select desired font 
in the Font list, click OK 
button

Other Ways

C6167_PPT_02.4c.indd   109C6167_PPT_02.4c.indd   109 3/7/07   10:38:19 AM3/7/07   10:38:19 AM



PPT 110   PowerPoint Chapter 2   Creating a Presentation with Illustrations and Shapes

To Shadow Text

A shadow helps the letters display prominently by adding a shadow behind the text. The following step adds a 
shadow to the selected title text, Reduce Access to Personal Data.

1
• With the text 

selected, click the 
Text Shadow button 
in the Font group 
on the Home tab 
to add a shadow 
to the selected text 
(Figure 2–33).

How would I remove 
a shadow?

You would click the 
Shadow button a 
second time, or you 
immediately could 
click the Undo but-
ton on the Quick 
Access Toolbar.

Shadow button

text to be 
formatted 
is selected

shadow applied 
to selected title 

Figure 2–33

Q
&

A

To Change Font Color

Color is used to emphasize or draw attention to specifi c text. The following step changes the title text font 
color from black to dark red.

1
• With the text selected, click the 

Font Color box arrow in the Font 
group on the Home tab to display 
the Font Color gallery (Figure 2–34).

What is the difference between 
the colors shown in the Theme 
Colors area and the Standard 
Colors?

The ten colors in the top row of 
the Theme Colors area are two 
text, two background, and six 
accent colors in the Offi ce Theme; 
the fi ve colors in each column 
under the top row display 
different transparencies. The ten 
standard colors are available in 
every document theme.

Font Color 
box arrow

default font 
color is black

Figure 2–34 

Font 
Color 
gallery

Theme Colors area 
displays colors assigned 
to Offi ce Theme 
document theme

Q
&

A
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Format Painter
To save time and avoid formatting errors, you can use the Format Painter to apply 

custom formatting to other places in your presentation quickly and easily. You can use 
this feature in three ways:

• To copy only character attributes, such as font and font effects, select text that has 
these qualities.

• To copy both paragraph attributes, such as alignment and indentation and character 
attributes, select the entire paragraph.

• To apply the same formatting to multiple words, phrases, or paragraphs, double-click 
the Format Painter button and then select each item you want to format. You then 
can press the ESC key or click the Format Painter button to turn off this feature.

2
• Point to the Dark Red color in the 

Standard Colors row to display a 
live preview of the title text in a 
Dark Red color (Figure 2–35).

I Experiment

• Point to various colors in the Font 
Color gallery and watch the title 
text color change in the slide.

desired 
Dark Red 
color is 
selected

Dark Red 
font color is 
previewed

Figure 2–35

3
• Click Dark Red to change the title 

text font color.

How would I change a color?

You would click the Font Color 
box arrow and then select another 
color in the Font Color gallery.

Q
&

A

1. Click Font color box arrow 
on Mini toolbar, click 
desired color in Font Color 
gallery

2. Right-click selected text, 
click Font on shortcut 
menu, click Font tab, select 
desired color in Font color 
list, click OK button

3. Click Dialog Box Launcher 
in Font group, click Font 
tab, select desired color 
in Font color list, click OK 
button

4. Press CTRL+SHIFT+F, click 
Font tab, select desired 
color in Font color list, click 
OK button

Other Ways

Deleting WordArt
If you decide you no 
longer want the WordArt 
text to display on your 
slide, select this text, click 
the Format tab on the 
Ribbon, click the Quick 
Styles button, and then 
click Clear WordArt.

B
T
W
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To Format Slide 3 Text Using the Format Painter

To save time and duplicated effort, you quickly can use the Format Painter to copy formatting attributes from the 
Slide 2 title text and apply them to Slides 3. The following steps use the Format Painter to copy formatting features.

1
• With the Slide 2 title text still 

selected, double-click the Format 
Painter button in the Clipboard 
group in the Home tab 
(Figure 2–36).

• Move the mouse pointer off 
the Ribbon.

Why did my mouse pointer 
change shape? 

The mouse pointer changed 
shape by adding a paint brush to 
indicate that the Format Painter 
function is active. 

Format Painter 
button selected

mouse 
pointer

Figure 2–36

formatted Slide 2 
title text is selected

Q
&

A

2
• Click the Next Slide button to 

display Slide 3. Triple-click the 
title text placeholder to apply 
the format to all the title text 
(Figure 2–37).

selected Slide 3 
title text is 
formatted

Figure 2–37
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To Format Remaining Title Text

Once you have applied formatting characteristics to one text placeholder, you 
should maintain consistency and apply the same formats to the other title text characters. 
The following steps use the Format Painter to change the font and font color and apply a 
shadow to the Slide 4 and Slide 1 title text.

1  Click the Next Slide button to display Slide 4. Triple-click the title text placeholder to apply 
the format to all title text characters.

What happened to all the letters in my title?

The Format Painter applied a style that does not fi t in the current placeholder. You will 
adjust the font size so that all the words are displayed.

2  Click the Previous Slide button three times to display Slide 1. Triple-click the title text 
placeholder to apply the format to all title text characters.

3  Press the ESC key to turn off the Format Painter feature (Figure 2–38).

Q
&

A

Other Ways

1. Click Format Painter 
button on Mini toolbar

Format Painter 
button not 
selected

Figure 2–38

Slide 1 title text 
is formatted
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To Size Slide 4 Text

The Slide 4 title text placeholder is too small to accommodate the formatting 
characteristics you applied to the text. The text will fi t if you reduce the font size. In 
addition, the body text should be enlarged for readability. The following steps adjust 
the size of the Slide 4 title and body text.

1  Click the Next Slide button three times to display Slide 4.

2  Select both body text paragraphs in the content text placeholder and then click the 
Increase Font Size button on the Mini toolbar four times to increase the font size 
to 24 point.

3  Triple-click the title text placeholder and then click the Decrease Font Size button on the 
Mini toolbar three times to reduce the font size to 32 point (Figure 2–39).

4  Click the slide anywhere outside the placeholders to deselect it.

Figure 2–39

title text font 
size is 32 point
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Adding and Formatting a Shape
One method of getting the audience’s attention at the start of a slide show is to have 
graphical elements on the title slide. PowerPoint provides a wide variety of shapes that 
can add visual interest to a slide. Shape elements include lines, basic geometrical shapes, 
arrows, equation shapes, fl owchart symbols, stars, banners, and callouts.

Slide 1 in this presentation is enhanced in a variety of ways. First, the title text font 
size is increased to aid readability and to catch the audience’s attention. Then a shape is 
inserted below the title text with additional formatted text. Finally, the subtitle text 
placeholder is deleted because it no longer is needed.

To Increase Title Slide Font Size

The title on a slide should be large enough to stimulate the audience’s interest and 
announce the topic of the presentation. The following steps increase the Slide 1 title text.

1  Click the Previous Slide button three times to display Slide 1.

2  Select the Slide 1 title text, Protect Your Good Name. Click the Increase Font Size button 
on the Mini toolbar six times until the font size is 80 point (Figure 2–40).

3  Click the slide anywhere outside the title text placeholder to deselect it.

Figure 2–40

title text font 
size is 80 point
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To Add a Shape

After adding a shape to a slide, you can change its default characteristics by adding text, bullets, numbers, and 
Quick Styles. You also can combine multiple shapes to create a more complex graphic. The following steps add a 
banner shape to Slide 1.

1
• Click the Shapes button in the 

Drawing group on the Home tab to 
display the Shapes gallery. Point to 
the Wave banner shape in the Stars 
and Banners area (Figure 2–41).

Shapes button

desired 
Wave 
banner 
shape

Stars and 
Banners area

Figure 2–41

Shapes 
gallery

2
• Click the Wave shape (Figure 2–42).

Why did my pointer change shape?

The pointer changed to a plus 
shape to indicate the Wave shape 
has been added to the Clipboard. desired location 

for Wave shape

mouse pointer 
changes shape to 
block plus sign

Figure 2–42

Q
&

A

C6167_PPT_02.4c.indd   116C6167_PPT_02.4c.indd   116 3/7/07   10:38:32 AM3/7/07   10:38:32 AM



Po
w

er
Po

in
t 

C
h

ap
te

r 
2Adding and Formatting a Shape   PPT 117

To Resize a Shape

The next step is to resize the Wave shape. The shape should be enlarged so that it appears prominently on the 
slide and can hold the subtitle text. The following steps resize the selected Wave shape.

3
• Click Slide 1 anywhere below the 

title text to insert the Wave shape 
(Figure 2–43).

Wave 
shape 
inserted

Figure 2–43

Other Ways

1. Click More button in 
Insert Shapes group on 
Format tab in Drawing 
Tools tab

1
• With the Wave shape still selected, 

point to the lower-right corner 
sizing handle on the picture so 
that the mouse pointer shape 
changes to a two-headed arrow 
(Figure 2–44). 

What if my shape is not selected?

To select a shape, click it.

mouse pointer 
changes shape 
to two-headed 
arrow

Figure 2–44

Q
&

A
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2
• Drag the sizing handle diagonally 

outward and downward until the 
Wave shape is the approximate size 
of the one shown in Figure 2–45.

mouse pointer 
changes shape 
to crosshair

selection rectangle 
indicates original 
Wave shape size

Figure 2–45

3
• Release the mouse button to 

resize the shape (Figure 2–46).

What if the shape is the wrong size?

Repeat Steps 1 and 2. 

What if I want to move the shape 
to a different location on the slide?

With the shape selected, press the 
Arrow keys or drag the shape to 
the desired location.

Wave 
shape is 
resized

Figure 2–46

Q
&

A
Q

&
A

Other Ways

1. Enter shape height and 
width in Height and 
Width text boxes in 
Size group on Format 
tab in Drawing Tools 
contextual tabs

2. Click Dialog Box 
Launcher in Size 
group on Format 
tab in Drawing Tools 
contextual tabs, click 
Size tab, enter desired 
height and width values 
in text boxes, click Close 
button
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To Add Text to a Shape

The banner shape is displayed on Slide 1 in the correct location. The next step is to add text stating that 
the presentation will cover strategies to help prevent identity theft. The following step describes how to add this 
information to the shape.

To Format Shape Text and Add a Shape Quick Style

Formatting text in a shape follows the same techniques as formatting text in a placeholder. You can change 
font, font color and size, and alignment, and you also can apply a Shape Quick Style. The following steps describe 
how to format the shape text by increasing the font size and adding a Shape Quick Style.

1
• With the Wave banner shape se-

lected, type Reduce Your Risk 
of Identity Theft in the shape 
(Figure 2–47).

text added to 
Wave shape

Figure 2–47

shape text font 
size is 18 point

1
• Triple-click the Wave shape text to 

select it and then click the Increase 
Font Size button on the Mini 
toolbar fi ve times until the font 
size is 36 point (Figure 2–48).

Figure 2–48

Increase 
Font Size 
button

shape text font 
size increases 
to 36 point
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2
• Click the Shape Quick Styles button 

in the Drawing group on the Home 
tab to display the Quick Styles 
gallery (Figure 2–49).

• Point to the Subtle Effect – Accent 6 
Shape Quick Style (row 4, column 7) 
to display a live preview of the style.

I Experiment

• Point to various styles in the Quick 
Styles gallery and watch the format 
of the text, backgrounds, and 
borders change in the Wave shape.

Quick Styles 
button

desired Quick 
Styles effect

default 
Quick 
Style

default Quick 
Style effect is 
previewed in 
shape

Figure 2–49

Quick 
Styles 
gallery

3
• Click the Subtle Effect – Accent 6 

Shape Quick Style (row 4, column 7) 
to apply this format to the shape. 

4
• Click outside the shape to 

deselect it (Figure 2–50).

Figure 2–50

Subtle Effect – 
Accent 6 Quick Style 
effect is applied to 
shape text
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2
• Press the DELETE key to delete 

the placeholder. If necessary, 
select the shape and then use the 
ARROW keys to center the shape 
under the title text (Figure 2–52).

To Delete a Placeholder

The subtitle placeholder no longer is necessary on Slide 1 because the shape fi lls the area below the title text. 
The following steps delete the Slide 1 subtitle placeholder.

1
• Click the subtitle text placeholder 

border two times to change the 
border to a solid line (Figure 2–51).

subtitle text 
placeholder 
changes to 
solid line

Figure 2–51

subtitle text 
placeholder 
is deleted

Figure 2–52
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Adding a Transition
PowerPoint provides many animation effects to add interest and make a slide show 
presentation look professional. Animation includes special visual and sound effects 
applied to text or content. A slide transition is a special animation effect used to progress 
from one slide to the next in a slide show. You can control the speed of the transition 
effect and add a sound.

PowerPoint provides more than 50 different transitions in the Quick Styles group. 
They are arranged into fi ve categories that describe the types of effects:

• Fades and Dissolves - Blend one slide seamlessly into the next slide
• Wipes - Gently uncover one slide to reveal the next
• Push and Cover - Appear to move one slide off the screen
• Stripes and Bars – Use blinds and checkerboard patterns
• Random – Use vertical and horizontal bars or an arbitrary pattern that changes each 

time you run the presentation.

Use simple transitions.
Transitions help segue one slide into the next seamlessly. They should not be used 
decoratively or be something on which an audience member focuses. For consistency, 
use the same transition throughout the presentation unless you have a special circumstance 
that warrants a different effect.

Plan 
Ahead

To Add a Transition between Slides

In this presentation, you apply the Uncover Right transition in the Wipes category to all slides and change the 
transition speed to Medium. The following steps apply this transition to the presentation.

1
• Click the Animations 

tab on the Ribbon 
and then point to 
the More button 
in the Transition 
to This Slide group 
(Figure 2–53).

Is a transition 
applied now? 

No. The fi rst 
slide icon in the 
Transitions group has 
an orange border, 
which indicates no 
transition has been 
applied.

Q
&

A

More button
Animations tab

selected icon 
indicates no 
transition is 
applied 

Figure 2–53

Transition 
to This Slide 
group

Certifi cation
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you 
to obtain a valuable 
industry credential – 
proof that you have the 
PowerPoint 2007 skills 
required by employers. 
For more information 
see Appendix F or visit 
the PowerPoint 2007 
Certifi cation Web page 
(scsite.com/ppt2007/cert).

B
T
W
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2
• Click the More button to expand 

the Transitions gallery.

• Point to the Uncover Right 
transition (row 2, column 2) 
in the Wipes category in the 
Transitions gallery to display a 
live preview of this transition 
(Figure 2–54).

I Experiment

• Point to various styles in the 
Transitions gallery and watch the 
transitions on the slide. 

desired 
transition

no star under slide 
number indicates 
no transition is 
applied

Figure 2–54

no transition 
is applied

3
• Click Uncover Right in the Wipes 

category in the Transitions 
gallery to apply the Uncover Right 
transition to the title slide.

Why does a star appear next to 
Slide 1 in the Slides tab?

The star indicates that a transition 
animation effect is applied to 
that slide.

• Click the Transition Speed arrow 
in the Transition to This Slide 
group on the Animations tab 
to display three 
possible speeds: Slow, Medium, 
and Fast (Figure 2–55).

Transition 
Speed arrow

Fast is default 
transition speed

star under slide 
number indicates 
transition animation 
effect is applied

Figure 2–55

three 
transition 
speed options

Q
&

A

Transitions 
gallery
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4
• Click Medium to change the 

transition speed for Slide 1 to 
Medium.

• Click the Apply to All button 
in the Transition to This Slide 
group on the Animations tab 
to apply the Uncover Right 
transition and Medium speed 
to all four slides in the 
presentation (Figure 2–56).

What if I want to apply a 
different transition and 
speed to each slide in the 
presentation? 

Repeat Steps 2 through 5 for 
each slide individually. 

Apply To 
All button

Medium transition 
speed applied

Figure 2–56

stars indicate animation 
is applied to all slides in 
presentationQ

&
A

To Change Document Properties

Before saving the presentation again, you want to add your name, class name, 
and some keywords as document properties. The following steps use the Document 
Information Panel to change document properties.

1  Click the Offi ce Button to display the Offi ce Button menu, point to Prepare on the Offi ce 
Button menu, and then click Properties on the Prepare submenu to display the Document 
Information Panel.

2  Click the Author text box, if necessary, and then type your name as the Author property. 
If a name already is displayed in the Author text box, delete it before typing your name.

3  Click the Subject text box, if necessary delete any existing text, and then type your course 
and section as the Subject property.

4  Click the Keywords text box, if necessary delete any existing text, and then type identity 
theft, Internet safeguards, PIN as the Keywords properties.

5  Click the Close the Document Information Panel button so that the Document 
Information Panel no longer is displayed.
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To Save an Existing Presentation with the Same File Name

You have made several changes to the presentation since you last saved it. Thus, you 
should save it again. The following step saves the document again.

1  Click the Save button on the Quick Access Toolbar to overwrite the previous Identity Theft 
fi le on the USB fl ash drive.

To Run an Animated Slide Show

All changes are complete, and the presentation is saved. You now can view the Identity 
Theft presentation. The following step starts Slide Show view.

1  Click the Slide Show button to display the title slide (Figure 2–57).

2  Click each slide and view the transition effect and slides.

Printing a Presentation as an Outline and Handouts
During the development of a lengthy presentation, it often is easier to review an outline 
in print rather than on the screen. Printing an outline also is useful for audience handouts 
or when your supervisor or instructor wants to review your subject matter before you 

Figure 2–57
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1
• Click the Offi ce 

Button to display the 
Offi ce Button menu.

• Point to Print on 
the Offi ce Button 
menu to display 
the Print submenu 
(Figure 2–58).

develop the presentation fully. In addition, printing two or more slides on one page helps 
audience members see relationships between slides and also conserves paper. You can 
preview your print selections to see how your printout will look.

The Print What list in the Page Setup group or in the Print dialog box contains 
options for printing slides, handouts, notes, and an outline. If you want to print handouts, 
you can specify whether you want one, two, three, four, six, or nine slide images to display 
on each page. The next two sections preview and then print the presentation outline and 
the presentation slides as a handout.

To Preview and Print an Outline

Recall that in Chapter 1 each slide printed on a separate page when you clicked Quick Print on the Print 
submenu. When you want to print other materials, such as an outline, notes, or handouts, you click Print on the 
Print submenu and select what form of output you desire. The following steps preview and print an outline.

clicking Print 
button displays 
Print submenu

clicking Print Preview 
button displays 
preview of slide, 
handout, or outline

Figure 2–58

Quick Reference
For a table that lists how 
to complete the tasks 
covered in this book 
using the mouse, Ribbon, 
shortcut menu, and 
keyboard, see the Quick 
Reference Summary at 
the back of this book, or 
visit the PowerPoint 2007 
Quick Reference Web page 
(scsite.com/ppt2007/qr).

B
T
W

C6167_PPT_02.4c.indd   126C6167_PPT_02.4c.indd   126 3/7/07   10:38:53 AM3/7/07   10:38:53 AM



Po
w

er
Po

in
t 

C
h

ap
te

r 
2Printing a Presentation as an Outline and Handouts   PPT 127

2
• Click Print Preview on the Print 

submenu to display a preview of 
a slide, handout, or outline of the 
presentation.

Why does the slide preview image 
vary among slides, handouts, and 
outlines?

PowerPoint retains the 
settings last specifi ed for 
previewing and printing. If, 
for example, you last speci-
fi ed to print in Grayscale, the 
current document will print 
in Grayscale unless you change 
the setting. 

• If an outline is not previewed, 
click the Print What box arrow in 
the Page Setup group on the Print 
Preview tab to display a list of 
output types in the Print What list 
(Figure 2–59).

Print What 
box arrow

Print Preview tab

Slides is current 
output type

Slide 1 
appears as 
print preview

Figure 2–59

Outline View 
is desired 
output type

Print What 
list shows 
output types

3
• Click Outline View in the Print 

What list if this choice is not 
already selected.

• Click the Zoom button in the 
Zoom group on the Print Preview 
tab to open the Zoom dialog box.

• Click 100% in the Zoom dialog box 
to change the zoom so that you 
can read the outline easily on the 
screen (Figure 2–60).

If I change the zoom percentage, 
will the document print differently?

Changing the zoom has no effect 
on the printed document.

OK button

Zoom button

Zoom dialog box

Outline View is 
preview type

presentation 
outline 
appears as 
print preview

Figure 2–60

100% is 
desired 
zoom

Q
&

A
Q

&
A
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4
• Click the OK button 

in the Zoom dialog 
box to zoom the 
outline.

• Drag the scroll box 
on the vertical scroll 
bar up or down to 
move through the 
outline text 
(Figure 2–61).

If I do not want to 
print my outline 
now, can I cancel 
this print request?

Yes. Click the Cancel 
button in the Print 
dialog box to return 
to Normal view.

dragging scroll 
box on vertical 
scroll bar allows 
you to view all 
outline text

Figure 2–61

presentation is 
displayed as 
outline at 100%

Q
&

A

5
• Click the Print button in the Print 

group on the Print Preview tab 
to display the Print dialog box 
(Figure 2–62).

What if my Print dialog box 
displays a different printer name?

It is likely a different printer name 
will display. Just ensure that the 
printer listed is the correct device 
you want to use to print your 
outline.

Print button

OK button

Print dialog box

presentation 
outline will print

Figure 2–62

Q
&

A
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6
• Click the OK button 

to print the outline 
(Figure 2–63). current date 

is displayed 
in header

page number 
is displayed 
in footer

Figure 2–63

Other Ways

1. Drag Zoom slider on 
status bar

2. Click Zoom button on 
status bar, select desired 
zoom percent or type, 
click OK button

To Preview and Print Handouts

Printing handouts is useful for reviewing a presentation because you can analyze 
several slides displayed simultaneously on one page. Additionally, many businesses distribute 
handouts of the slide show before a presentation so the attendees can refer to a copy.

The default slide print order is Horizontal so that Slides 1 and 2, and 3 and 4 are 
adjacent to each other. You can change this order to Vertical, which shows Slides 1 and 4, 
and 2 and 3 adjacent to each other, by clicking Options in the Print group on the Print 
Preview tab and then changing the printing order.

The following steps preview and print presentation handouts.

1  Click the Print What box arrow in the Page Setup group.

2  Click Handouts (4 Slides Per Page) in the Print What list. Drag the scroll box on the vertical 
scroll bar up or down to move through the page.

3  Click the Print button in the Print group.

4  Click the OK button in the Print dialog box to print the handout (Figure 2–64).

5  Click the Close Print Preview button in the Preview group on the Print Preview tab to 
return to Normal view.
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Saving and Quitting PowerPoint
If you made any changes to your presentation since your last save, you should save 

it again before quitting PowerPoint. The following steps save changes to the presentation 
and quit PowerPoint.

page number 
is displayed 
in footer

current date 
is displayed 
in header

Figure 2–64

C6167_PPT_02.4c.indd   130C6167_PPT_02.4c.indd   130 3/7/07   10:39:02 AM3/7/07   10:39:02 AM



Po
w

er
Po

in
t 

C
h

ap
te

r 
2Chapter Summary   PPT 131

To Quit PowerPoint

This project is complete. The following steps quit PowerPoint.

1  Click the Close button on the right side of the title bar to quit PowerPoint.

2  If necessary, click the Yes button in the Microsoft Offi ce PowerPoint dialog box so that 
any changes you have made are saved.

Chapter Summary
In this chapter you have learned how to create slides from a blank presentation, change slide layouts, add a background 
style, insert clip art and pictures, size graphic elements, apply Quick Styles, select slide transitions, and preview and print 
an outline and handout. The items listed below include all the new PowerPoint skills you have learned in this chapter.

 1. Choose a Background Style (PPT 89)
 2. Change the View to Slide Sorter View (PPT 91)
 3. Change the View to Normal View (PPT 91)
 4. Change the Slide Layout to Two Content 

(PPT 92)
 5. Change the Slide Layout to Picture with Caption 

(PPT 94)
 6. Insert a Clip from the Clip Organizer into a 

Content Placeholder (PPT 96)
 7. Insert a Photograph from the Clip Organizer into a 

Slide (PPT 98)
 8. Insert a Photograph from a File into a Slide 

(PPT 99)
 9. Resize Clip Art (PPT 100)
 10. Resize a Photograph (PPT 103)
 11. Delete a Placeholder (PPT 104)
 12. Move Clips (PPT 105)

 13. Format Title Text Using Quick Styles (PPT 106)
 14. Format Remaining Title Text Using Quick Styles 

(PPT 107)
 15. Change the Heading Font (PPT 109)
 16. Shadow Text (PPT 110)
 17. Change Font Color (PPT 110)
 18. Format Text Using the Format Painter (PPT 112)
 19. Format Remaining Title Text (PPT 113)
 20. Add a Shape (PPT 116)
 21. Resize a Shape (PPT 117)
 22. Add Text to a Shape (PPT 119)
 23. Format Shape Text and Add a Shape Quick Style 

(PPT 119)
 24. Add a Transition between Slides (PPT 122)
 25. Preview and Print an Outline (PPT 122)
 26. Preview and Print Handouts (PPT 129)

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.
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Learn It Online

Test your knowledge of chapter content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and 
then enter the Web address scsite.com/ppt2007/learn. When the Offi ce 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content.

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions.

Practice Test
A series of multiple choice questions that test 
your knowledge of chapter content and key terms.

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter.

Apply Your Knowledge 

Reinforce the skills and apply the concepts you learned in this chapter.

Changing the Background and Adding Photographs and a Quick Style
Instructions: Start PowerPoint. Open the presentation, Apply 2-1 Lifestyle, from the Data Files   
for Students. See the inside back cover this book for instructions on downloading the Data Files for 
Students, or contact your instructor for more information about accessing the required fi les.

The four slides in the presentation present basic guidelines for maintaining a healthy lifestyle 
and focus on proper weight, exercise, and food choices. The document you open is an unformatted 
presentation. You are to add and size photographs, change the background style, change slide layouts, 
apply a transition, and use the Format Painter so the slides look like Figure 2-65.

Perform the following tasks:
 1. Change the background style to Style 11 (row 3, column 3). On the title slide, use your name in 

place of Student Name and bold and italicize your name and change the font color to orange. 
Increase the title text font size to 72 point, change the font to Baskerville Old Face, and change the 
font color to Dark Blue.

 2. On Slides 2 and 4, change the layout to Two Content and then insert the photographs shown in 
Figure 2-65b and 2-65d from the Microsoft Clip Organizer.

 3. On Slide 3, change the layout to Picture with Caption and then insert the picture shown in 
Figure 2-65c from the Microsoft Clip Organizer. Delete the text placeholder. Change the title text 
font size to 44 point, center this text, and then add the italic font style and shadow effect. Use the 
Format Painter to format the title text on Slides 2 and 4.

 4. Apply the Subtle Effect – Accent 1 Quick Style (row 4, column 2) to the Slides 2, 3, and 4 title text 
placeholders. Apply the Uncover Left wipe transition (row 2, column 1) to all slides.
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 5. Check the spelling, and then display the revised presentation in Slide Sorter view.

 6. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Apply 2–1 Healthy Lifestyle. Submit the revised document in the format specifi ed by 
your instructor.

background 
Style 11 applied

name is bold, 
italicized, 
and orange

title text font 
is dark blue 72 
point Baskerville 
Old Face

Two Content 
layout

Subtle Effect –
Accent 1 Quick 
Style applied to 
placeholder

title text font is 
44 point italic, 
centered, with a 
shadow effect

Picture with 
Caption layout

Two Content 
layout

Figure 2–65

(a)

(c)

(b)

(d)
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Figure 2–66

variety of 
clips to 
consider 
moving to 
previous 
slides in 
presentation

Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Changing Slide Layouts and Moving Clips
Instructions: Start PowerPoint. Open the presentation, Extend 2-1 Fats, from the Data Files for 
Students. See the inside back cover of this book for instructions on downloading the Data Files for 
Students, or contact your instructor for more information on accessing the required fi les.

You will choose a background, format slides, and copy clips (Figure 2–66).

Perform the following tasks:
 1. Add an appropriate background style.

 2. On Slide 1, use your name in place of Student Name. Format the text using techniques you 
learned and applied in this chapter, such as changing the font size and color and also bolding and 
italicizing words.

 3. Slide 7 contains a variety of clips downloaded from the Microsoft Clip Organizer. Review the slides 
in the presentation and then move clips from Slide 7 to the appropriate slides. You do not need to use 
all the clips. Delete Slide 7 when you have fi nished moving the desired clips to the slides.

 4. Change the slide layouts to accommodate the clips. Size the clips when necessary. Edit the text so 
that each slide meets the 7 � 7 rule, which states that each line should have a maximum of seven 
words, and each slide should have a maximum of seven lines.

 5. Apply an appropriate transition to all slides.

 6. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Extend 2-1 Enhanced Fats.

7.  Submit 
the revised 
document in 
the format 
specifi ed 
by your 
instructor.
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clip art too small and 
overlapping text 

change document 
theme to Paper and 
apply background style

Figure 2–67

misspellings

Make It Right

Analyze a presentation and correct all errors and/or improve the design.

Applying Background and Quick Styles
Instructions: Start PowerPoint. Open the presentation, Make It Right 2-1 Safety, from the Data Files 
for Students. See the back inside cover of this book for instructions on downloading the Data Files for 
Students, or contact your instructor for more information on accessing the required fi les.

Correct the formatting problems and errors in the presentation while keeping in mind the 
guidelines presented in this chapter.

Perform the following tasks:
 1. Change the document theme from Verve, shown in Figure 2–67, to Paper. Apply the Style 7 

background style (row 2, column 3).

 2. On Slide 1, replace the words, Student Name, with your name. Apply a Quick Style to your name 
and the title text so that they display prominently on the slide.

 3. Move Slide 2 to the end of the presentation so that it becomes the new Slide 5.

 4. Use the spell checker to correct the misspellings. Analyze the slides for other word usage errors 
that the spell checker did not fi nd.

 5. Adjust the clip art sizes so they do not overlap text and are the appropriate dimensions for the slide 
content.

 6. Select a Quick Style to apply to the Slides 2 through 5 title text. Center the title text and apply a shadow.

 7. Apply an appropriate transition to all slides. Change the speed to Slow.

 8. Change the 
document 
properties, as 
specifi ed by your 
instructor. Save 
the presentation 
using the fi le 
name, Make It 
Right 2-1 Home 
Safety.

 9. Submit the 
revised document 
in the format 
specifi ed by your 
instructor.
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In the Lab

Design and/or create a presentation using the guidelines, concepts, and skills presented in 
this chapter. Labs 1, 2, and 3 are listed in order of increasing diffi culty.

Lab 1: Creating a Presentation with a Clip and Shapes
Problem: The ear affects balance while it enables us to hear. This organ can be divided into three 
parts for analysis: outer, middle, and inner. The outer ear is composed of a fl ap and the auditory canal. 
The middle ear has three tiny bones called the auditory ossicles and the eustachian tube, which links 
the ear to the nose. The inner ear contains the spiral-shaped cochlea and also the semicircular canals 
and the vestibule, which control balance. You are studying the ear as a unit in your health class, so you 
decide to develop a PowerPoint slide that names these parts to help you study for a quiz. Create the 
slide shown in Figure 2–68 from a blank presentation.

Instructions: Perform the following tasks.
 1. Apply the Style 6 background style (row 2, column 2) to the slide. Change the layout to Content 

with Caption. Import the ear diagram clip from the Microsoft Clip Organizer.

 2. Type the slide title and caption body text shown in Figure 2–68. Use your name in place of Bill 
Tracy, and then italicize this text and change the font color to Blue (color 8 in the Standard Colors 
row). Change the color of the title text to Dark Red (color 1 in the Standard Colors row) and 
increase the font size to 24.

 3. Use the Right Arrow, Left Arrow, Up Arrow, and Down Arrow shapes in the Block Arrow section 
to point to the parts of the ear shown in Figure 2–68. Add the number to each arrow. Apply the 
Subtle Effect – Accent 3 Quick Style (row 4, column 4) to each arrow. Change the font size of each

     arrow text to 
     24 point and bold 
     these numbers.

4.   Check the spelling 
and correct any 
errors.

5.   Change the 
document 
properties, as 
specifi ed by your 
instructor. Save the 
presentation using 
the fi le name, 
Lab 2-1 Ear.

6.   Submit the revised 
document in the 
format specifi ed by 
your instructor.

Figure 2–68

Style 6 
background style

24 point 
Dark Red 
title text

substitute your 
name, and then 
format the text

Block 
Arrow 
shapes
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Continued >

In the Lab

Lab 2: Creating a Presentation with Photographs Inserted from a File
Problem: Destructive insects damage specifi c species of trees throughout the world. You have learned 
in your Botany 202 class that the Asian Longhorn Beetle, the Emerald Ash Borer, the Gypsy Moth, 
and the Western Pine Beetle are among trees’ biggest pests. One of your assignments in your botany 
class is to give a speech about common tree pests. You develop the outline shown in Figure 2–69 and 
then prepare the PowerPoint presentation shown in Figures 2–70a through 2–70f. You have obtained 
permission from the U.S. Forestry Department to copy photographs from its Web site to your slide 
show; these photographs are on your Data Files for Students.

Figure 2–69
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In the Lab continued

Instructions: Perform the following tasks.
 1. Create a new presentation using the Foundry document theme. Apply the Style 7 background style 

(row 2, column 3).

 2. Using the typed notes illustrated in Figure 2–69, create the title slide shown in Figure 2–70a using 
your name in place of Jim DeYoung. Bold your name and apply a shadow. 

 3. Insert the Isosceles Triangle shape (row 1, column 3 in the Basic Shapes category) in the top center 
of Slide 1. Size the shape so that the top and bottom align with the edges of the brown area of the 
slide, as shown in Figure 2–70a.

 4. Using the typed notes in Figure 2–69, create the fi ve text slides with bulleted lists shown in 
Figures 2–70b through 2–70f. Use the Two Content slide layout for Slides 2 through 5 and the 
Title and Content slide layout for Slide 6.

 5. Insert the appropriate pictures from your Data Files for Students on Slides 2 through 5.

 6. Apply the Wedge transition (row 1, column 5 in the Wipes category) to all slides. Change the 
speed to Medium. Check the spelling and correct any errors.

 7. Review the slides in Slide Sorter view to check for consistency, and then change the view to Normal.

 8. Drag the scroll box to display Slide 1. Click the Slide Show button to start Slide Show view. Then 
click to display each slide.

 9. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Lab 2-2 Tree Pests.

 10. Submit the document in the format specifi ed by your instructor.

picture 
inserted 
from disk

(b)

Figure 2–70

substitute your 
name, and then 
format the text

(a)

Isosceles Triangle 
shape inserted 
and sized

Foundry document 
theme and Style 7 
background style 
applied
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picture 
inserted 
from disk

(e ) (f)

Figure 2–70

picture 
inserted 
from disk

picture 
inserted 
from disk

(c) (d)
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Figure 2–71

Instructions: Perform the following tasks.
 1. Use the typed notes illustrated in Figure 2–71 to create four slides shown in Figures 2–72a through 

2–72d from a blank presentation. Apply the Style 7 background style (row 2, column 3). Use your 
name in place of Bryan Howell on the title slide shown in Figure 2–72a. Bold your name.

 2. Insert the Right Triangle shape (row 1, column 4 in the Basic Shapes category) on Slide 1. With the 
shape selected, click the Arrange button in the Drawing group on the Home tab, point to Rotate in 
the Position Objects group, and then click Flip Horizontal to turn the triangle shape. Drag the shape 
to the lower-right corner of the slide, increase the size to that shown in Figure 2–72a, and apply the 
Colored Outline - Accent 3 Quick Style (row 1, column 4).

In the Lab

Lab 3: Creating a Presentation with Clips and Shapes
Problem: Snowboarding’s popularity has soared in recent years; even Cameron Diaz and Space Shuttle 
astronauts have a passion for the sport. But with this increase in snowboarders has come a corresponding 
increase in injuries. The most common injuries are caused by a failure to follow common sense precautions. 
In order to maximize the time on the slopes, snowboarders need to prepare for the sport by wearing proper 
equipment, getting into condition, and snowboarding under control. Bryan Howell owns a local ski and 
snowboard shop in your town and has asked you to prepare a PowerPoint presentation that he can share 
with equipment buyers and renters. He hands you the outline shown in Figure 2–71 and asks you to create 
the presentation shown in Figures 2–72a through 2–72d.
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 3. Italicize the Slide 1 title text, Prepare for Snowboarding Season, align the text left, and change the 
font color to Black. Align the subtitle text left and change the font color to Green (color 6 in the 
Standard Colors row).

 4. Add the photographs and clip art shown in Figures 2–72a through 2–72d from the Microsoft Clip 
Organizer. Adjust the clip sizes when necessary.

 5. Change the Slide 2 title text font size to 54 point, change the font to Forte, and then change the 
color to Green. Use the Format Painter to format the title text on Slides 3 and 4 with the same 
features as on Slide 2.

 6. Apply the Newsfl ash transition (row 6, column 2 in the Wipes category) to all slides. Change the 
speed to Medium. Check the spelling and correct any errors.

 7. Click the Slide Sorter view button, view the slides for consistency, and then click the Normal 
view button.

 8. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Lab 2-3 Snowboarding.

 9. Submit the revised document in the format specifi ed by your instructor.

Right Triangle shape 
inserted, fl ipped, 
and dragged to this 
location

formatted 
title text

substitute your 
name, and then 
format the text

Colored Outline – 
Accent 3 Quick 
Style applied

formatted 
title text 

clip inserted 
and sized

clip inserted 
and sized

photograph 
inserted and sized

Figure 2–72

(a) (b)

(c) (d)

clip inserted 
and sizedStyle 7 

background 
applied
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Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution.

• EASIER    •• MORE DIFFICULT

Note: Remember to use the 7 � 7 rule as you design the presentations: a maximum of seven words on 
a line and a maximum of seven lines on one slide.

• 1: Design and Create an Energy Effi ciency Presentation
Global demand, industry deregulation, and regional confl icts have increased energy prices. The 
United States Department of Energy predicts energy use will grow 33 percent by 2030. Despite these 
staggering numbers, homeowners can undertake relatively simple measures to be energy effi cient. 
Create a presentation using the outline in Figure 2–73. Apply at least three objectives found at the 
beginning of this chapter to develop the presentation. Add a title slide with a shape and a closing slide 
that cites your references. Be sure to check spelling.

Figure 2–73
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Continued >

• 2: Design and Create a Hypertension Presentation
According to the National Heart, Lung, and Blood Institute, nearly one-third of American adults 
are infl icted by the “silent killer,” high blood pressure. This disease affects people of all ages and 
ethnicities. Use the concepts and techniques presented in this chapter to create a presentation 
following the outline in Figure 2–74, which includes the defi nition of hypertension and hypertension 
categories, has tips on controlling high blood pressure, and lists Web sites to view for further 
information. Insert photographs and clips, and apply a subtle slide transition to all slides. Be sure to 
check spelling.

Figure 2–74
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Cases and Places continued

•• 3: Design and Create a Portable Media Player Presentation
Video tape recorders were immensely popular more than three decades ago with several competing 
standards introduced in the market. Each technology touted different features. Today, the situation is 
similar with portable media players and cellular telephones that can download music from the Internet 
or rip fi les from your computer. Your supervisor at NextPhase Electronics recognizes buyers need 
assistance learning about these devices. She has asked you to prepare a presentation summarizing one 
of these players for next month’s Saturday Seminar Series at the store. Research a specifi c portable 
media player and create a slide for each of the following attributes: featured model, user interface, and 
fi nding and loading songs. Select art and photographs from the Microsoft Clip Organizer, and add a 
title slide and summary slide to complete your presentation. Format the title slide with a shape and the 
text with colors and bolding where needed for emphasis.

•• 4: Design and Create a Campus Orientation Presentation

Make It Personal
Feedback from new students at your school cites diffi culties navigating your campus. Incoming 
students mention the library, registrar, and health services as locations most often sought. To address 
these concerns, you volunteered as a member of the New Student Orientation Team to create a 
presentation and distribute a handout showing frequently accessed areas of the school. Use the 
concepts and techniques presented in this chapter to develop and format a slide show with a title slide 
and at least three text slides with bulleted lists. Create a slide for each landmark that briefl y describes 
its location, and use clips and text to annotate it. Obtain a map of your campus and import it as a 
picture into your presentation. Select slide layouts that permit both the map and a bulleted list to 
appear on each slide. Use the arrow shapes to indicate the location of the landmark on the map. Add 
a background style and slide transitions. Be sure to check spelling. Print a handout with two slides on 
each page to distribute to new students on campus.

•• 5: Design and Create a Wellness Program Presentation

Working Together
Health care costs continue to rise at nearly double the infl ation rate. Many health insurance companies 
are becoming proactive in containing those costs by offering reimbursement for wellness programs. 
Have each member of your team visit, telephone, or view Web sites of three health insurance 
companies. Gather information about:
1) Health screenings

2) Fitness center amenities

3) Self-Improvement classes

4) Wellness program benefi ts
After coordinating the data, create a presentation with a least one slide showcasing each topic. As a 
group, critique each slide. Submit your assignment in the format specifi ed by your instructor.
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